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Preface

This document provides installation instructions for the Forte™ for Java™, release

4.0, Enterprise Edition integrated development environment (IDE). Topics covered

include:

■ Overview of the installation steps

■ System requirements

■ Supported platforms

■ Installation of Java™ 2 Platform, Standard Edition, v. 1.4.0

■ Application servers with the IDE

■ Setting up databases with the IDE

■ Contents of top-level directories of the IDE

■ Registering with Forte for Java Developer Resources

■ Updating modules with the Update Center

■ Uninstalling the IDE

■ Using the startup command-line switches

■ Other documentation resources

How This Book Is Organized

Chapter 1 gives an overview of the general installation process and information on

system requirements for Forte for Java, release 4.0, Enterprise Edition.

Chapter 2 provides instructions on installing and uninstalling the Java 2 Platform,

Standard Edition, v. 1.4.0 on your system.

Chapter 3 describes the steps to install the Forte for Java IDE on the supported

platforms. The subdirectories installed with the IDE are described and uninstallation

instructions are also provided.
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Chapter 4 gives instructions on how to start and set up the newly installed Forte for

Java IDE. The command-line options are provided and information about product

registration is also included.

Chapter 5 steps you through the validation of the Forte for Java IDE installation

using a J2EE™ Reference Implementation 1.3 instance and a simple HelloWorld

application.

Chapter 6 provides some information for customizing your IDE installation using a

PointBase Restricted Edition 4.2 database.

Chapter 7 gives information on integrating other application servers with the IDE.

Chapter 8 describes steps to update the IDE modules using the Forte for Java Update

Center. Information about other documentation resources are also included in this

chapter.

Chapter 9 provides some troubleshooting hints and Appendix A lists the Solaris

patches that are included with the J2SE, v.1.4.0 installer for the Solaris operating

environment.
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Typographic Conventions

Related Documentation

See http://forte.sun.com/ffj/documentation/index.html for more

information on documentation related to the Forte for Java, release 4.0, Enterprise

Edition.

Accessing Sun Documentation Online

The docs.sun.com SM web site enables you to access a select group of Sun technical

documentation on the Web. You can browse the docs.sun.com archive or search

for a specific book title or subject at:

http://docs.sun.com

Typeface Meaning Examples

AaBbCc123 The names of commands, files,

and directories; on-screen

computer output

Edit your.login file.

Use ls -a to list all files.

% You have mail .

AaBbCc123 What you type, when

contrasted with on-screen

computer output

% su

Password:

AaBbCc123 Book titles, new words or terms,

words to be emphasized,

command-line variables

Read Chapter 6 in the User’s Guide.

These are called class options.

You must be superuser to do this.

To delete a file, type rm filename.
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Sun Welcomes Your Comments

Sun is interested in improving its documentation and welcomes your comments and

suggestions. You can email your comments to Sun at:

docfeedback@sun.com

Please include the part number (816-4063-05) of your document in the subject line of

your email.
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CHAPTER 1

Preparing for Installation

This chapter contains information needed to prepare for the installation of the

Forte™ for Java™, release 4.0, Enterprise Edition IDE (hereinafter referred to as Forte

for Java IDE).

Overview of the Installation

The following is the general process to follow to install the Forte for Java IDE on

your system. The process includes the validation, customization, and registration of

your Forte for Java IDE installation.

1. Verify that you have local or network access to either Java™ 2 Platform, Standard

Edition, v. 1.3.1 (hereinafter, referred to as J2SE™, v. 1.3.1 platform) or Java™ 2

Platform, Standard Edition, v.1.4.0 (hereinafter, referred to as J2SE™, v. 1.4.0

platform) from the system in which you plan to install the Forte for Java IDE.

Note – The recommended option is for you to use the J2SE, v. 1.4.0 platform with

the Forte for Java IDE. Read “Installing the J2SE, v. 1.4.0 Platform” on page 9 for

detailed installation instructions.

2. Verify that the system you will use for installation meets the minimum system

requirements. See “System Requirements” on page 7 for more information.

3. Determine which software you will want the Forte for Java IDE installer to install.

The Forte for Java, release 4.0, Enterprise Edition installer includes the following

software:

■ Forte for Java, release 4.0, Enterprise Edition Core Platform and Modules

(required)

■ PointBase Server 4.2 Restricted Edition

■ J2EE™ Reference Implementation 1.3
5



■ Solaris™ Developer Modules (available on Solaris operating environments

only)

Note – The recommendation is for you to install the J2EE Reference Implementation

1.3 and the PointBase Server 4.2 Restricted Edition with the IDE. These software

products are conveniently provided to allow you to quickly develop a simple J2EE

application, as described in “Validating Your Forte for Java Installation” on page 37.

4. Determine if you want to keep your previous version of the Forte for Java IDE.

■ If you do, identify a different directory in which to install the Forte for Java,

release 4.0, Enterprise Edition.

■ If you want to install over a previous version of the IDE, decide whether you

want to backup the files from the previous IDE version.

5. Determine whether you want to keep your current Forte for Java IDE user

settings.

■ If you decide to use your current user settings with the new IDE version, you

need to specify the location of your current user directory when prompted

during the initial IDE setup. Read “Using Your Newly Installed Forte for Java

IDE” on page 31 for more information.

6. Install Forte for Java, release 4.0, Enterprise Edition. Read “Installing the Forte for

Java IDE” on page 19 for detailed installation instructions for each of the

supported platforms.

7. Set up your initial IDE environment and register the product. Read “Using Your

Newly Installed Forte for Java IDE” on page 31 for instructions on setting up your

user directory and registering the product.

8. Validate your installation of the Forte for Java IDE by starting an instance of the

J2EE Reference Implementation server and creating a simple J2EE application.

Read “Validating Your Forte for Java Installation” on page 37 for additional

information.

After you have validated that your Forte for Java IDE installation is working

properly, perform the following steps, if desired.

1. Customize your Forte for Java IDE installation by setting up the PointBase

database server or migrating the applications you developed in a previous

version of the IDE. Refer to the instructions in “Customizing Your Installation” on

page 43.

2. Configure the use of other application servers with the Forte for Java IDE. Read

“Using Other Application Servers with the Forte for Java IDE” on page 47 for

configuration instructions.
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Supported Platforms

This release of the Forte for Java, release 4.0, Enterprise Edition has been tested with

Solaris 8 operating environment (SPARC platform) and Microsoft Windows 2000

system. It is recommended that you use these platforms for your evaluation of this

release.

This release has been tested on a limited basis on the Red Hat Linux 6.2 environment

and Microsoft Windows NT4, SP6 system.

System Requirements

TABLE 1-1 lists the system requirements needed to install a minimum or

recommended configuration on any of the supported platforms. The memory

recommendations assume you are developing and testing J2EE™ applications or web

services. The recommended configurations are dependent on the application server

and database used for development.

These are general guidelines. Your requirements might vary depending on what

additional software you have installed for use with the Forte for Java IDE.

TABLE 1-1 Forte for Java, release 4.0, Enterprise Edition System Requirements

Supported platform

Free hard disk space
required for
installation)

Minimum
configuration

Recommended
configuration

Solaris ™ 8

Operating

Environments

(SPARC Platform)

320MB Ultra-60, 450Mhz,

512MB RAM

SunBlade 1000 with

750-900MHz, 768

RAM

Windows 2000,
Windows NT4, SP6 1

1. This release has been tested on a limited basis on the Red Hat Linux 6.2 environment and Microsoft
Window NT4, SP6 system.

180 MB Pentium III,

500Mhz, 512 MB

RAM

Pentium III, 1 Ghz,

768 MB RAM

Red Hat Linux 6.2 1 180 MB Pentium III

500Mhz,

512 MB RAM

Pentium III, 1 Ghz,

768 MB RAM
Chapter 1 Preparing for Installation 7
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CHAPTER 2

Installing the J2SE, v. 1.4.0 Platform

This chapter gives instructions for verifying what version of the J2SE platform to

which you currently have access. If you need to install J2SE, v. 1.4.0 platform on your

system, this chapter also gives step-by-step instructions for installing the J2SE, v.

1.4.0 platform on all the supported platforms. The J2SE, v. 1.4.0 platform is

comprised of the Java 2 Software Development Kit, Standard Edition (Java 2 SDK)

and the Java Software Runtime Environment, Standard Edition (JRE).

Verifying Your J2SE Platform Version

To use the Forte for Java IDE, you must have one of the following:

■ J2SE, v. 1.3.1 or J2SE, v. 1.4.0 platform installed on your system

■ Network access to the path in which the J2SE, v. 1.3.1 or J2SE, v. 1.4.0 platform is

installed

The recommendation is for you to use the J2SE, v. 1.4.0 platform with the Forte for

Java IDE. If you run the Forte for Java IDE without J2SE, v.1.3.1 or J2SE, v. 1.4.0

platform installed or available, you get error and warning messages.

Note – To maximize runtime performance, it is highly recommended that the J2SE

be installed on and accessed from your local system.

Use the following steps to help you determine what you need to do next.
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1. Identify which Java™ version is available to your system, by typing the following:

The output looks similar to the following:

If you do not have J2SE, v. 1.3.1 or J2SE, v. 1.4.0 platform available to your system,

you must install the supported J2SE, v. 1.4.0 platform.

2. If you do not have J2SE, v. 1.3.1 or J2SE, v. 1.4.0 platforms available to your system
do the following:

a. Obtain the J2SE, v.1.4.0 installer from http://forte.sun.com/eap or from
the Forte for Java CD.

b. Install the J2SE, v. 1.4.0 platform on your system.

Read the section following for additional instructions for your specific system.

3. (Solaris only) If you do have the supported J2SE, v. 1.4.0 platform on your system,
you might require the Solaris patches that are applicable to your version of the
Solaris operating environment.

If you do not have the required Solaris patches when you invoke the Forte for Java

IDE, you will receive a message that includes the Solaris patches you need to install

on your system. Install the patches on your system or contact your system

administrator.

Note – The J2SE, v. 1.4.0 installer for the Solaris s operating environment also

includes required Solaris software patches. For a complete list of the Solaris patches

that are installed with the J2SE, v. 1.4.0 platform, see “Solaris Patch Identifications

and Descriptions” on page 57.

% java -version

% java -version
java version "1.4.0"
Java(TM) 2 Runtime Environment, Standard Edition (build 1.4.0-b92)
Java HotSpot(TM) Client VM (build 1.4.0-b92, mixed mode)
10 Forte for Java, Enterprise Edition, release 4.0, Getting Started Guide • March 2002



Installation on Microsoft Windows
Systems

To install the J2SE, v. 1.4.0 platform on your Microsoft Windows system, follow these

steps:

1. If you have not already done so, download the j2sdk-1_4_0-rc-win.exe file
from http://forte.sun.com/eap or access it from the Forte for Java CD.

2. Double-click the j2sdk-1_4_0-rc-win.exe file to invoke the installation
wizard.

3. Follow the instructions on the installation wizard panes to complete the
J2SE, v. 1.4.0 platform installation on your Microsoft Windows system.

Installation in the Red Hat Linux
Environment

To install the J2SE, v. 1.4.0 platform in a supported Red Hat Linux environment,

follow these steps:

1. If you have not already done so, download the
j2sdk-1_4_0-rc-linux-i386-rpm.bin file from
http://forte.sun.com/eap or access it from the Forte for Java CD

2. Double-click the j2sdk-1_4_0-rc-linux-i386-rpm.bin file to invoke the
installation wizard.

3. Follow the instructions on the installation wizard panes to complete the
J2SE, v. 1.4.0 platform installation in your Red Hat Linux environment.
Chapter 2 Installing the J2SE, v. 1.4.0 Platform 11



Installation in the Solaris Operating
Environments

In a supported Solaris operating environment, there are two ways to install the J2SE,

v. 1.4.0 platform and Solaris patches in :

■ Web Start graphical user interface (see “Using the Web Start Graphical User

Interface” on page 12 for instructions)

■ installer command-line installation executable if you do not have graphical

user interface capabilities (see “Using the Web Start Command-Line Installation”

on page 14 for instructions)

Using the Web Start Graphical User Interface

These instructions describe how to use the Web Start software to install the

J2SE, v. 1.4.0 platform and Solaris patches.

1. If you have not already done so, download the j2se1.4_installer.tar.gz file
from http://forte.sun.com/eap or access it from the Forte for Java CD

2. Determine the directory, into which you want to extract the downloaded J2SE
installer file.

3. From the download directory, uncompress and extract the contents of the
downloaded J2SE, v.1.4.0 installer file into the extract-directory by typing:

Note – The gzcat utility can be found in the /usr/bin directory in the Solaris 8

operating environment.

4. To recover disk space, remove the downloaded tar file by typing:

% cd download-directory
% gzcat j2se1.4_installer.tar.gz  | (cd extract-directory; tar xvf - )

% rm -rf  j2se1.4_installer.tar.gz
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5. Go to the directory that was created when you untarred the downloaded file. For
example, if the file you untarred is j2se1.4_installer.tar , then type the
following

6. Become a superuser (root) by typing:

7. Start the Web Start Installer

Note – Do not run the installer in the background.

8. In the Welcome screen, click Next.

9. Click Next to install in /usr .

Note – The recommendation is for you to install the J2SE, v. 1.4.0 platform and

Solaris patches in the /usr directory.

The installation directory that you choose is your default installation directory for

this Web Start session.

10. Select the components you want to install and click Next.

The default selections of J2SE SDK, v. 1.4.0 and Solaris patches for J2SE platform are

recommended for installation. To change the default selections, select the

components you want to install.

11. Verify the items that you want to install and click Next.

To make changes to your selection, click Back.

12. Click Install Now to proceed with installation.

The Installing pane appears with a progress indicator.

% cd extract-directory
% cd j2se1.4_installer

% su
Password: root-password

# ./installer
Chapter 2 Installing the J2SE, v. 1.4.0 Platform 13



Note – Some of the Solaris patches take a long time to install and can cause the

J2SE, v. 1.4.0 installation process to take a few hours. The progress indicator may

seem stalled, but the installation is actually still in progress.

13. After installation is complete, click the Details button to get information about
the installation.

14. Review the messages in the Installation Summary pane. Click Exit to complete the
installation.

Note – Some Solaris patches require that you reboot your system after installation

has completed. The installer prompts you to reboot, if necessary.

15. Exit from superuser privileges by typing:

Using the Web Start Command-Line Installation

These instructions describe how to use the Web Start software to install the J2SE, v.

1.4.0 platform and Solaris patches.

1. If you have not already done so, download the j2se1.4_installer.tar.gz file
from http://forte.sun.com/eap or access it from the Forte for Java CD

2. Determine the directory into which you want to extract the downloaded J2SE
installer file.

3. From the download directory, uncompress and extract the contents of the
downloaded J2SE, v.1.4.0 installer file into the extract-directory by typing:

Note – The gzcat utility can be found in the /usr/bin directory in the Solaris 8

operating environment.

# exit

% cd download-directory
% gzcat j2se1.4_installer.tar.gz  | (cd extract-directory; tar xvf - )
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4. To recover disk space, remove the downloaded tar file by typing:

5. Become a superuser (root) by typing:

6. Go to the directory that was created when you untarred the downloaded file. For
example, if the file you untarred is j2se1.4_installer.tar , then type the
following:

7. Start the command-line installation by typing:

Note – Do not run the installer in the background.

After the installer opens, the following message appears:

8. Press the Enter key. The Enter key is equivalent to the Return key on some
keyboards.

Note – Throughout the command-line installation, you can press the Enter key to

select the default selections.

9. Specify a location for installation.

% rm -rf downloaded-file.tar

% su
Password: root-password

% cd extract-directory
% cd j2se1.4_installer

# ./ installer -nodisplay

Solaris Web Start will assist you in installing software for J2SE
SDK 1.4.0 and Patches.

This installer will assist you in installing J2SE SDK 1.4 and
Patches software on your system.
Chapter 2 Installing the J2SE, v. 1.4.0 Platform 15



Note – The recommendation is for you to install the J2SE, v. 1.4.0 platform and

Solaris patches in the /usr directory.

10. Select the components you want to install. The default selections of
J2SE SDK, v. 1.4.0 and Solaris patches for J2SE platform are recommended for
installation. To change the default selections, do the following:

a. Select or deselect a component for installation by entering the number
corresponding to the component, and press Enter.

b. When finished, type 0 and press Enter.

11. A list of components will be shown for verification.

■ Type 1 if you want to proceed with installation.

■ Type 2 if you want to start over from Step 8.

■ Type 3 if you want to exit installation.

12. If you typed 1 to proceed with installation, a progress indicator appears.

a. When installation is complete, you can view a product’s log file by typing the
number corresponding to that product.

b. When you are finished viewing the log files, type the number corresponding to
Done.

13. After installation is complete, select the number corresponding to Details to get
information about the installation.

14. Exit from superuser privileges by typing:

Continue to “Installing the Forte for Java IDE” on page 19 for Forte for Java software

installation instructions.

Uninstalling the J2SE, v. 1.4.0 Platform

Use the following information to uninstall the J2SE, v1.4.0 platform from your

system:

■ In a Microsoft Windows system, use the Add/Remove Programs utility in the

Control Panel to uninstall the J2SE, v. 1.4.0 platform from your system.

# exit
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■ For RedHat Linux environment, use the rpm command to uninstall the J2SE,

v.1.4.0 platform from your system.

■ For Solaris operating environments, use the pkgrm and patchrm commands to

uninstall the J2SE, v. 1.4.0 platform and associated Solaris patches from your

system.

Caution – Removing the J2SE, v. 1.4.0 software and related Solaris patches can

cause regressive behavior on your system.

Refer to “Solaris Patch Identifications and Descriptions” on page 57 for

information on patches that were included with the J2SE, v.1.4.0 platform

installation.

Use man pkgrm and man patchrm for additional information on these

commands.
Chapter 2 Installing the J2SE, v. 1.4.0 Platform 17
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CHAPTER 3

Installing the Forte for Java IDE

This chapter contains information on upgrading from previous releases of the Forte

for Java IDE and instructions on how to install Forte for Java, release 4.0, Enterprise

Edition on each of the supported platforms.

Supporting Previous Forte for Java
Software Releases

To upgrade your previous version of the Forte for Java IDE to release 4.0, you can

choose from one of the following:

■ uninstall your previous version of the IDE, or

■ you can preserve your previous version of the IDE and install release 4.0 in a new

installation directory.

Uninstalling Your Previous Version of the Forte

for Java IDE

If you are upgrading from a previous version and would like to uninstall your

previous version of the IDE, use the following steps to guide you in preserving your

previous IDE user settings:

1. Run the Forte for Java, release 4.0 installer.

Read “Installing the Forte for Java IDE on the Supported Platforms” on page 21 for

more details on installing the IDE on your system.
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2. Specify the previous IDE version’s installation directory as the destination
directory in which to install the new version of the IDE.

The installer checks the destination directory you have specified and you will be

prompted whether you want to save the contents of the directory.

3. Confirm whether you want to remove the contents of the destination directory.

The installer proceeds with the installation of the Forte for Java, release 4.0,

Enterprise Edition in the destination directory.

4. After the installation has completed, launch the new IDE and specify the previous
version’s installation directory when prompted for the location of the previous
version of the IDE.

The Import Settings wizard imports the user settings from the previous version. See

“Setting up Your Forte for Java IDE” on page 31 for more details about setting your

user directory.

Preserving Your Previous Version of the Forte for

Java IDE

If you would like to keep the previous version of the IDE and want to use the same

IDE user settings for release 4.0, use the following steps as a guide to what needs to

be done:

1. Run the Forte for Java, release 4.0, Enterprise Edition installer.

Read “Installing the Forte for Java IDE on the Supported Platforms” on page 21 for

more information on installing the IDE on your system.

2. Specify a new directory as the destination directory in which to install the new
version of the IDE.

3. After the installation has completed, launch the new IDE and specify the previous
version’s installation directory when prompted for the location of the previous
version of the IDE.

The Import Settings wizard imports the user settings from the previous version. See

“Setting up Your Forte for Java IDE” on page 31 for more details about setting your

user directory.
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Creating a Shared Installation

If you want to share a Forte for Java installation between multiple users, you must

install the Forte for Java IDE into a shared directory.

■ After installation of the IDE in the supported Solaris operating and Red Hat

Linux environments, all user settings are stored in the ffjuser40ee_ea
directory created under each user’s home directory. This occurs for both shared

and unshared installations.

■ After installation of the IDE in a Microsoft Windows system, you must set your

own user directory using a dialog box that appears immediately upon initial

startup of the IDE from your machine. This occurs for both shared and unshared

installations.

The recommendation is for you to name the user directory as

drive:fully_qualified_path\ffjuser40ee_ea .

Installing the Forte for Java IDE on the
Supported Platforms

These instructions describe the installation process for each of the supported

platforms.

Installation on Microsoft Windows Systems

You can install the Forte for Java IDE on a supported Microsoft Windows system

through an .exe file.

Note – You must have the J2SE, v. 1.3.1 platform or J2SE, v. 1.4.0 platform installed

on your system before installing the Forte for Java IDE. The recommended option is

for you to use the J2SE, v. 1.4.0 platform with the Forte for Java IDE. Read “Installing

the J2SE, v. 1.4.0 Platform” on page 9 for instructions on installing the J2SE, v. 1.4.0

platform.

1. Double-click the ffj_ee_win32_en.exe file.

The InstallShield’s Welcome screen appears.
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Note – If you encounter any errors at any point during the Forte for Java IDE

installer, refer to “Troubleshooting” on page 51 for some troubleshooting hints.

2. In the Welcome screen, click Next.

3. Read the license agreement carefully. To agree, accept the terms of the license
agreement, and click Next.

You must agree to the license to continue with the installation.

InstallShield attempts to locate a compatible JDK™ v. 1.3.1 or JDK v. 1.4.0 on your

system.

4. Set the location of a compatible JDK software and click Next.

The Forte for Java IDE requires local or network access to either a JDK v. 1.3.1

software or JDK v. 1.4.0 software. Specify which installed JDK software to use by

doing one of the following:

■ accept the default location,

■ select another location from the list of found JDKs, or

■ click Browse to specify a different location.

Click Next after you have set the JDK location.

5. Click Next without entering a serial number to generate a trial serial number.

a. Click Yes to automatically generate a trial serial number

The trial serial number expires on August 31, 2002.

b. Note down the trial serial number that appears.

The trial serial number gives you access to the Update Center services once you

have registered the product. Read“Using Your Newly Installed Forte for Java

IDE” on page 31 for product registration information and “Updating Modules

With the Update Center” on page 49 for information on the Forte for Java Update

Center.

c. Click Next a second time to continue with the installation.

6. Accept the default installation folder or click Browse to install the IDE in a
directory of your choosing. Click Next to continue.

Note – The installation directory name cannot contain any spaces.

7. In the Select Features dialog box, select the desired features.

The following are the features available:

■ Forte for Java, release 4.0, Enterprise Edition Core Platform and Modules

(required)
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■ PointBase Server 4.2 Restricted Edition

■ J2EE Reference Implementation 1.3

Note – The recommendation is for you to install the J2EE Reference Implementation

1.3 and the PointBase Server 4.2 Restricted Edition with the IDE. These software

products are conveniently provided to enable you to quickly develop a simple J2EE

application, as described in “Validating Your Forte for Java Installation” on page 37.

8. Confirm your installation choices in the installation summary dialog box and click
Next.

InstallShield installs the Forte for Java features you have selected.

9. Choose whether you wish to associate .java and .nbm files with the Forte for Java
IDE. Click Next to continue.

If you choose to associate these file types, the Forte for Java IDE will automatically

launch when you choose to open these files.

10. Click Finish to complete the installation.

11. Review the Release Notes file for important information regarding the release.
You may access the Release Notes from
http://forte.sun.com/ffj/documentation/index.html .

12. Continue to “Using Your Newly Installed Forte for Java IDE” on page 31 for
information on setting up the Forte for Java IDE.

Installation in the Red Hat Linux Environment

You can install the Forte for Java IDE in a supported Red Hat Linux environment

with a .bin file.

Note – You must have the J2SE, v. 1.3.1 platform or J2SE, v. 1.4.0 platform installed

on your system before installing the Forte for Java IDE. The recommended option is

for you to use the J2SE, v. 1.4.0 platform with the Forte for Java IDE. Read “Installing

the J2SE, v. 1.4.0 Platform” on page 9 for instructions on installing the J2SE, v. 1.4.0

platform.
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1. Execute the ffj_ee_linux_en.bin file by typing the following command.

The -is command switch is optional and javahome is the path to your installed

J2SE, v. 1.3.1 or J2SE, v. 1.4.0 platform. An example of javahome is /usr/j2se:

Note – If you encounter any errors at any point during the Forte for Java IDE

installer, refer to “Troubleshooting” on page 51 for some troubleshooting hints.

2. In the Welcome screen, click Next.

3. Read the license agreement carefully. To agree, accept the terms of the license
agreement, and click Next.

You must agree to the license to continue with the installation.

InstallShield attempts to locate a compatible JDK™ v. 1.3.1 or JDK, v.1.4.0 platform on

your system.

4. Set the location of a compatible JDK software and click Next.

The Forte for Java IDE requires local or network access to either a JDK, v. 1.3.1

software or JDK, v. 1.4.0 software. Specify which installed JDK software to use by

doing one of the following:

■ accept the default location,

■ select another location from the list of found JDKs, or

■ click Browse to specify a different location.

Click Next after you have set the JDK location.

5. Click Next without entering a serial number to generate a trial serial number.

a. Click Yes to automatically generate a trial serial number

The trial serial number expires on August 31, 2002.

b. Note down the trial serial number that appears.

The trial serial number gives you access to the Update Center services once you

have registered the product. Read“Using Your Newly Installed Forte for Java

IDE” on page 31 for product registration information and “Updating Modules

With the Update Center” on page 49 for information on the Forte for Java Update

Center.

c. Click Next a second time to continue with the installation.

6. Accept the default installation folder or click Browse to install the IDE in a
directory of your choosing. Click Next to continue.

$ ffj_ee_linux_en.bin [-is:javahome javahome ]
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Note – The installation directory name cannot contain any spaces.

7. In the Select Features dialog box, select the desired features.

The following are the features available:

■ Forte for Java, release 4.0, Enterprise Edition Core Platform and Modules

(required)

■ PointBase Server 4.2 Restricted Edition

Note – The J2EE Reference Implementation 1.3 is not supported on the Red Hat

Linux environment for this release of the IDE.

8. Confirm your installation choices in the installation summary dialog box and click
Next.

InstallShield installs the Forte for Java features you have selected.

9. Click Finish to complete the installation.

10. Review the Release Notes file for important information regarding the release.
You may access the Release Notes from
http://forte.sun.com/ffj/documentation/index.html .

11. Continue to “Using Your Newly Installed Forte for Java IDE” on page 31 for
information on setting up Forte for Java IDE.

Installation in the Solaris Operating Environments

You can install the Forte for Java IDE in a supported Solaris™ operating environment

with a .bin file.

Note – You must have the J2SE, v. 1.3.1 platform or J2SE, v. 1.4.0 platform installed

on your system before installing the Forte for Java IDE. The recommended option is

for you to use the J2SE, v. 1.4.0 platform with the Forte for Java IDE. Read “Installing

the J2SE, v. 1.4.0 Platform” on page 9 for instructions on installing the J2SE, v. 1.4.0

platform.
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1. Execute the ffj_ee_solsparc_en.bin file by typing the following command:

The -is command switch is optional and javahome is the path to your installed

J2SE v. 1.3.1 or J2SE v. 1.4.0 platform. An example of javahome is /usr/j2se.

Note – If you encounter any errors at any point during the Forte for Java IDE

installer, refer to “Troubleshooting” on page 51 for some troubleshooting hints.

2. In the InstallShield’s Welcome screen, click Next.

3. Read the license agreement carefully. To agree, accept the terms of the license
agreement, and click Next.

You must agree to the license to continue with the installation.

InstallShield attempts to locate a compatible JDK™, v. 1.3.1 or JDK, v. 1.4.0 software

on your system.

4. Set the location of a compatible JDK software and click Next.

The Forte for Java IDE requires local or network access to either a JDK v. 1.3.1

software or JDK v. 1.4.0 software. Specify which installed JDK software to use by

doing one of the following:

■ accept the default location,

■ select another location from the list of found JDKs, or

■ click Browse to specify a different location.

Click Next after you have set the JDK location.

5. Click Next without entering a serial number to generate a trial serial number.

a. Click Yes to automatically generate a trial serial number

The trial serial number expires on August 31, 2002.

b. Note down the trial serial number that appears.

The trial serial number gives you access to the Update Center services once you

have registered the product. Read“Using Your Newly Installed Forte for Java

IDE” on page 31 for product registration information and “Updating Modules

With the Update Center” on page 49 for information on the Forte for Java Update

Center.

c. Click Next a second time to continue with the installation.

6. Accept the default installation folder or click Browse to install the IDE in a
directory of your choosing. Click Next to continue.

$ ffj_ee_solsparc_en.bin [-is:javahome javahome ]
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Note – The installation directory name cannot contain any spaces.

7. In the Select Features dialog pane, select the desired features.

The following are the features available:

■ Forte for Java, release 4.0, Enterprise Edition Core Platform and Modules

(required)

■ PointBase Server 4.2 Restricted Edition

■ J2EE Reference Implementation 1.3

■ Solaris Developer Modules

Note – The recommendation is for you to install the J2EE Reference Implementation

1.3 and the PointBase Server 4.2 Restricted Edition with the IDE. These software

products are conveniently provided to enable you to quickly develop a simple J2EE

application, as described in “Validating Your Forte for Java Installation” on page 37.

8. Specify the path to the Forte Compiler Collection if you chose to install the
Solaris Developer Modules.

If you have not installed the Forte Compiler Collection or you do not readily know

the path to the Forte Compiler Collection, leave the FCC Path blank and click Next.

You may download the Forte Compiler Collection software from

http://access1.sun.com/fortedevprod/fd7compilers .

You may set or reset the FCC path at a later time by using the forte_fcc utility,

which can be found in ffj-install-dir/bin/forte_fcc . Read the forte_fcc man
page at ffj-install-dir/man/man1 for additional information.

9. Confirm your installation choices in the installation summary pane and click
Next.

InstallShield installs the Forte for Java features you have selected.

10. Click Finish to complete the installation.

11. Review the Release Notes file for important information regarding the release.
You may access the Release Notes from
http://forte.sun.com/ffj/documentation/index.html .

12. Continue to “Using Your Newly Installed Forte for Java IDE” on page 31 for
information on setting up the Forte for Java IDE.
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Finding Installation Subdirectories

After you have installed the Forte for Java IDE, the subdirectories listed in TABLE 3-1

can be found under ffj-install-dir, your Forte for Java installation directory:

TABLE 3-1 Forte for Java Installation subdirectories.

Subdirectory name Description

/_uninst Contains the files used to uninstall in the IDE

/beans Contains JavaBeans™ components installed in the IDE

/bin Includes the Forte for Java startup scripts (as well as the

ide.cfg file in Microsoft Windows installations)

/docs Contains the Forte for Java help files and other miscellaneous
documentation

/emacs (Solaris only) Contains emacs files, if you chose to install the
Solaris Developer Modules

/iPlanet Contains iPlanet-specific files, such as the executable for the
iPlanet Application Server plug-in

/j2sdkee1.3 Contains the J2EE Reference Implementation v. 1.3 files, if
you chose to install it during the Forte for Java installation
process

/lib Contains the JAR files that make up the IDE’s core
implementation and the open APIs

/man (Solaris only) Contains man pages for Solaris Developer
Modules, if installed

/modules Stores Forte for Java modules as JAR files

/platform (Solaris only) Contains platform specific files

/pointbase Contains four subdirectories, client , database , docs , and
server . The client directory contains PointBase console,
command-line utilities, and examples of a PointBase
application and a WebServer application. The database
directory contains sample databases. The docs directory
contains PointBase documentation. The server directory
contains the PointBase server.
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Uninstalling the Forte for Java IDE

An uninstaller wizard is made available to assist you in the uninstallation of the

Forte for Java IDE. Follow the steps below to uninstall your copy of the Forte for

Java IDE, release 4.0

1. Invoke the uninstaller from ffj-install-dir/_uninst directory.

■ In the supported Solaris operating environment or Red Hat Linux environment,

type:

■ In the Microsoft Windows system, execute the uninstaller.exe file located at

ffj-install-dir/_uninst directory or use the Add/Remove Program utility in the

Control Panel.

The uninstaller’s Welcome screen appears.

2. Click Next from the Welcome screen.

A list of Forte for Java features is displayed.

3. Select the features you want to uninstall and click Next.

4. Click Next to confirm the features to be uninstalled.

The uninstaller wizard proceeds with the uninstallation of the IDE.

/sources Contains sources for libraries that might be redistributed
with user applications

/system Includes files and directories used by the IDE for special
purposes. Go to your individual ffj-user-dir/system
directory to get the ide.log , which provides information
useful when requesting technical support, and to view
project.basic and project.last files, which contain
information on Forte for Java projects. In a Microsoft
Windows system, this ffj-user-dir/system directory contains
the project specific files under project.basic_hidden and
project.last files.

/tomcat401 Contains Tomcat specific files

$ java -jar uninstall.jar

TABLE 3-1 Forte for Java Installation subdirectories.

Subdirectory name Description
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5. Click Finish to close the uninstaller wizard.
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CHAPTER 4

Using Your Newly Installed Forte
for Java IDE

After you have successfully installed the Forte for Java IDE, use the information in

this chapter to launch, set up and register your Forte for Java IDE. Details about the

available command-line switch options are also included.

Setting up Your Forte for Java IDE

When you first start up the Forte for Java IDE, you are prompted to specify the user

directory to use with the IDE, whether you would like automatic update checking,

and to register your Forte for Java IDE software. Use the following steps to guide

you through setting up your initial IDE environment.

1. Start the Forte for Java IDE

■ For the supported Solaris operating environments or Red Hat Linux environment,

type:

$ cd ffj-install-dir /bin
$ runide.sh
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■ For the Microsoft Windows system, click the Start menu and select Forte for Java

4.0 EE > Forte for Java or from a command prompt window, type:

A popup dialog window appears and asks you to specify the fully qualified path

for the user directory.

2. Specify the name of your user directory.

■ For supported Solaris operating or Red Hat Linux environments, the default user

directory name is $HOME/ffjuser40ee_ea .

■ On a Microsoft Windows system, there is no default directory name. The

recommendation is for you to name the user directory as

drive:fully_qualified_path\ffjuser40ee_ea .

The Settings Import wizard appears.

3. Specify whether you want to import your settings from a previous version of the
IDE.

■ If you do not want to import your previous user settings, select No and click

Finish to exit the wizard.

■ If you want to import your previous user settings, select Yes and click Next.

You are prompted for the location of the previously installed IDE.

i. Specify the path or click Browse to locate the directory. Click Next

The IDE imports the settings.

ii. Click Finish to exit the wizard.

The IDE continues with the startup and several windows appear.

4. From the Automatic Update Check dialog, specify whether you want to check for
new IDE updates.

■ If you replied Yes, the Update Center wizard appears. Follow the instructions on

the wizard to complete the setup for automatic update checking.

■ If you replied No, you can invoke the Update Center wizard, at a later time, from

Tools > Update Center from the Main window of the IDE.

The registration wizard appears.

5. Register your Forte for Java IDE software using the registration wizard.

It is recommended that you register your Forte for Java IDE software to obtain the

many benefits offered to registered users. Read “Registering With Forte for Java

Developer Resources” on page 33 for more information.

C:\> cd ffj-install-dir \bin
C:\> runidew.exe
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a. Choose Register/Update now and click Next.

b. Select your preferred method of registration.

■ Web based registration

The recommendation is that you use the Web based registration, which allows

you to register your Forte for Java IDE software and also registers you with the

Forte for Java Developer Resources. For more information about the benefits of

registering with the Forte for Java Developer Resources, read “Registering

With Forte for Java Developer Resources” on page 33.

■ Email registration or Print for FAX and Postal mail

This method of registration allows you to register your Forte for Java IDE

software only. If you decide to register with the Forte for Java Developer

Resources at a later time, choose Help > Registration from the Main window of

the IDE.

If you choose not to register now, you can access the registration wizard by accessing

Tools > Registration Wizard from the Main window of the IDE.

6. Continue to “Validating Your Forte for Java Installation” on page 37 for
instructions on validating your installation of the IDE.

Registering With Forte for Java
Developer Resources

Registering with Forte for Java Developer Resources enables you to:

■ Use the Update Center to download and install new modules and updates

specific to your environment

■ Subscribe to the Early Access Program (http://forte.sun.com/eap ) and

receive new, non-public builds of the IDE, preview releases of Forte for Java

modules, patches and bug fixes

■ Receive product announcements, if desired

■ Use the same user name and password to access the Update Center, the Early

Access Program, and the Sun Download Center (from which you may have

downloaded the Forte for Java IDE)

To register with Forte for Java Developer Resources, go Help > Registration from the

Main window of the IDE or to

http://forte.sun.com/services/registration/new-user.
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If you are already registered with the Sun Download Center, mysun.sun.com , or

the Sun Store, you can use the same user name and password, but you will be

prompted for additional information. To update your account information, go to:

http://forte.sun.com/services/registration/
accountmaintenance.html.

Using the IDE Startup Command-Line
Options
The Forte for Java IDE startup scripts for all supported platforms can be run with

additional options. These command-line options are specified with flags.

In the supported Solaris operating environment, for example, you might type:

Alternatively, you can put the options in the ffj-install-dir/bin/ide.cfg file. The

IDE reads this file before parsing any command-line options. You can break options

into multiple lines in ide.cfg .

TABLE 4-1 lists the Forte for Java startup command-line options for all supported

platforms.

# runide.sh -help
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TABLE 4-1 Command-Line Switch Options

Switch Options Description

-h
-help

Prints usage.

-jdkhome jdk-home-dir Selects a JDK other than the default JDK. On

Microsoft Windows, by default, the IDE checks

the registry and selects the latest JDK available.

-hotspot
-server
-client
-classic
-native
-green

Explicitly specifies the JVM variant to be used.

-cp:p additional-classpath Prepends the specified classpath onto the IDE’s

classpath.

-cp:a additional-classpath Appends the specified classpath to the IDE’s

classpath.

-ui UI_class-name Selects a given class as Forte for Java’s look and

feel.

-fontsize size Sets the font size, expressed in points, in the

IDE’s user interface.

-single Launches the IDE from ffj-install-dir instead of

from your ffj-user-dir directory. Runs the Forte

for Java IDE in single-user mode. The default

mode is multi-user.

-fortecc fcc-path (Solaris only) Specifies the path to the Forte

Compiler Collection to use for this session of

the IDE. Overrides any default settings created

in the IDE or user directory.

-userdir ffj-user-dir Explicitly specifies the ffj-user-dir directory (the

location where your user settings are stored). If

this option is not used in Solaris or Linux

operating environments, the location is

user-home-dir/ffjuser40ee_ea . If this option

is not used in Microsoft Windows NT, the user

is prompted at the initial startup of the IDE for

the ffj-user-dir directory to use. On Microsoft

Windows systems, this value is stored in the

registry for later use.
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Solaris and Linux users can modify startup scripts to suit their needs.

-J jvm-flags Passes specified flags directly to the JVM.

-J-Xverify:none Tells the JVM not to verify the correctness of the

bytecode for faster startup. Bytecode

verification is a slow process since whenever a

class is loaded, the JVM scans all bytecode and

detects an invalid byte sequence even if a

method is never called. Also, the JVM loads

certain classes referred to in method signatures

and in the method body, even though they are

not called during startup. However, setting this

flag removes some of the protection that the

Java™ language gives you. (Refer to the JVM

documentation for more information.)

-J-Xms24m Sets up the initial heap size of the JVM to 24

MB. This switch prevents the JVM from

extending the heap size during startup, which

enables faster startup time for the IDE.

TABLE 4-1 Command-Line Switch Options (Continued)

Switch Options Description
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CHAPTER 5

Validating Your Forte for Java
Installation

This chapter contains information on how to validate your installation of the Forte

for Java, release 4.0, Enterprise Edition. Instructions are provided to help you

through the creation of a simple HelloWorld web application using the J2EE

Reference Implementation 1.3.

Note – The following instructions assume you have already installed the J2EE

Reference Implementation 1.3 during the IDE installation.

Starting the Default J2EE Reference
Implementation Instance

The J2EE Reference Implementation server is configured automatically when you

installed the J2EE Reference Implementation 1.3 during the Forte for Java IDE

installation. The RI_HOME environment variable is set and an instance of the J2EE

Reference Implementation is added to the IDE’s server registry. This instance is also

set to be the default application server after the IDE installation.

The following instructions explain how to start and verify the default J2EE Reference

Implementation server instance.

1. Verify that the RIHome environment variable is set correctly.

a. In the Explorer window of the IDE, click the Runtime tab and expand the
nodes for Server Registry and Installed Servers.

b. Right-click J2EE Reference Implementation 1.3 and choose Properties from the
contextual menu.

The property sheet for J2EE Reference Implementation appears.
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c. Verify that the RIHome property already has a value of
ffj-install-dir/j2sdkee1.3.

If it does not, set the value by selecting the RIHome property and typing the

correct value.

2. Start the J2EE Reference Implementation 1.3 instance.

a. Expand the Server Registry and Installed Server nodes from the Runtime tab of
the Explorer window.

All the applications servers that have already been installed are listed under the

Installed Server node.

a. Expand the J2EE Reference Implementation 1.3 node.

You will see the RI instances that have already been added to the Server Registry.

b. Right-click RI Instance 1 and select Start Server from the contextual menu.

The corresponding messages appear in the Output window. For example, in a

Solaris operating environment, you see the following:

3. Verify the server instance status in a web browser using
http://localhost:8000 for the URL.

If you have correctly integrated your server, you will see the J2EE 1.3 Default Home

Page.

Creating a HelloWorld J2EE Application

The following steps will guide you in creating a simple test application using the

J2EE Reference Implementation 1.3 that was installed with the IDE.

Note – The following instructions assume you have already started the default J2EE

Reference Implementation instance. See “Starting the Default J2EE Reference

Implementation Instance” on page 37 for more information.

1. Create a new directory called verificationApp .

J2EE server listen Port: = 1049
Redirecting the output and error streams to the following files:
<ffj-install-dir>/j2sdkee1.3/logs/myhost/j2ee/j2ee/system.out
<ffj-install-dir>/j2sdkee1.3/logs/myhost/j2ee/j2ee/system.err
J2EE server startup complete.
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2. Start the Forte for Java IDE, if you have not already done so.

■ On Microsoft Windows systems, click Forte for Java 4.0 EE > Forte for Java from

the Start menu or start a command window and type the following:

■ In the supported Solaris operating environment, type the following command

from the command line:

3. Mount the new verificationApp directory in the IDE.

a. Select File > Mount Filesystems from the Main window of the IDE.

The New Wizard appears.

b. Select Local Directory and click Next.

c. Select the newly created directory, verificationApp , and click Finish.

A new node for verificationApp appears on the Editing tab of the Explorer

window.

4. Create a new Java package named hello .

a. In the Filesystems tab of the Explorer window, right-click the
verificationApp node and select New > Java package.

The New wizard for Java Package appears.

b. Specify the name hello for the new Java package and click Finish.

A new node for the hello package appears on the Editing tab of the Explorer

window.

5. Create a new session EJB named helloBean .

a. In the Explorer window, right-click the hello node and select New > J2EE >
Session EJB.

The New wizard for Session EJB appears.

b. Specify the EJB Name as helloBean , use all the default settings on the New
wizard, and click Finish.

The new helloBean(EJB) node appears on the Editing tab of the Explorer

window. Nodes for helloBean , helloBeanEJB , and helloBeanHome also

appear.

C:\ ffj-install-dir \bin\runidew.exe

$ cd ffj-install-dir /bin
$ runide.sh [ ffj-ide-options ]
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6. Add a business method.

a. In the Explorer window, right-click the helloBean(EJB) node and select Add
Business Method.

The Add New Business Method dialog appears.

b. Name the method sayHello .

c. Set the return type by clicking on the down-arrow and selecting
java.lang.String .

d. Click OK.

7. Edit and compile the sayHello method.

a. In the Explorer window, expand the helloBean(EJB) node and expand the
Business Methods node.

b. Right-click on sayHello() , and choose Open.

The Source Editor opens and displays the contents of the helloBeanEJB method.

c. In the Source Editor, add one line, so the method looks like this:

d. Select Build > Compile or Press F9 to compile the sayHello method.

If no compilation errors were encountered, the Output Window should display

the message “Finished helloBeanEJB” .

8. Create a new EJB Test application.

a. In the Filesystems tab of the Explorer window, right-click on the
helloBean(EJB) node and choose Create New EJB Test Application.

The Create a new EJB Test Application dialog appears.

b. Accept all the default values by clicking OK.

An EJB-module called helloBean_EJBModule , a web-module named

hello_WebModule , and an application helloBean_TestApp are created and

automatically mounted in the IDE.

9. Run the helloBean_TestApp.

public java.lang.String sayHello() {
return “Hello there, client!”;

}
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a. In the Filesystems tab of the Explorer window, right-click the
helloBean_TestApp node and select Execute.

A progress monitor is displayed and the IDE switches to the Running workspace

tab. The helloBean_TestApp is deployed and your web browser should come

up with the URL displayed as

htpp://localhost:8000/helloBean_TestApp/dispatch.jsp .

b. If the browser does not come up automatically, bring it up manually and type
htpp://localhost:8000/helloBean_TestApp for the URL.

If the htpp://localhost:8000/helloBean_TestApp/dispatch.jsp page is

displayed, then the J2EE Reference Implementation server is working correctly.

You have now verified that your installation of the IDE and the J2EE Reference

Implementation is working properly. At this point, you can skip the next steps on

this chapter or continue with the next step to run the session bean’s method.

10. Run the session bean’s method.

a. From the htpp://localhost:8000/helloBean_TestApp/dispatch.jsp
page on your web browser, click the Invoke button next to hello.helloBean
create.

It is the first Invoke button on the page, under the Invoke Methods on

hello.helloBeanHome section.

b. In the EJB Navigation section of the next page, click hello.helloBean[7] .

The number 7 may be some other number on your web browser.

c. Click Invoke next to java.lang.String sayHello .

The Results of the Last Method Invocation section displays the following:

You have completed running the session bean’s method.

Hello there!

Method Invoked: sayHello()
Parameters:
none
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CHAPTER 6

Customizing Your Installation

This chapter contains information that would assist you in customizing your

installation of the Forte for Java, release 4.0, Enterprise Edition.

Using Databases With the Forte for Java
IDE

The Forte for Java IDE includes the PointBase Network Edition 4.2 database. You can

use other databases with the IDE by configuring the JDBC™ enabled database

drivers for those databases.

Using a PointBase Database With the IDE

PointBase Network Edition 4.2 database is the default database that is provided with

the Forte for Java IDE installation. For information on using this database and on

database tables, see the PointBase documentation at either

ffj-install-dir/pointbase/server/GettingStarted.html or

ffj-install-dir/pointbase/client/GettingStarted.html .

Starting the PointBase Database Server

You have to start the PointBase database server before you can use it, whether you

want to access a PointBase database from an application you developed using the

IDE or you want to create your own tables or database with PointBase.

To start the PointBase database server:
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● Choose Tools > PointBase Network Server > Start Server from the Main window
of the IDE.

Alternatively, on Microsoft Windows systems, start the PointBase server by choosing

Forte for Java 4.0 EE > PointBase > Network Server > Server from the Start menu.

The PointBase 4.2 window appears.

Stopping the PointBase Database Server

To stop the PointBase database server:

Note – The following action only stops the PointBase database server that was

started by Tools > PointBase Network Server > Start Server action.

● Choose Tools > PointBase Network Server > Stop Server from the Main window
of the IDE or choose Server > Shutdown! from the PointBase 4.2 window.

Starting the PointBase Client Console

To start a PointBase console, do the following

● In the supported Solaris operating and Red Hat Linux environments, type:

● On Microsoft Windows systems, start the PointBase client console by choosing
Forte for Java 4.0 EE > PointBase > Console from the Start menu.

Stopping the PointBase Client Console

To stop the client console, terminate the window from which it is running.

Note – Note that the above steps apply only to the locally installed version of the

PointBase database.

$ sh ffj-install-dir/pointbase/client/Console
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J2EE Reference Implementation 1.3 and PointBase Server

If you also installed J2EE Reference Implementation 1.3, note that it is pre-

configured to use the PointBase server included with the IDE. Starting the J2EE RI

server does not start the PointBase server. You must start the PointBase database

server as previously instructed in this section.

If, however, you want to create a different PointBase database for your tables, you

need to use the $J2EE_HOME/bin/j2eeadmin tool to update the

$J2EE_HOME/config/resource.properties file. The $J2EE_HOMEis set to the

ffj-install-dir/j2sdkee1.3 directory.

The j2eeadmin syntax is as follows:

Alternatively, you can manually edit the

$J2EE_HOME/config/resource.properties file and modify the

jdbc.resources variable, as follows:

Using Other JDBC Enabled Databases With the

IDE

The following information applies to database drivers other than PointBase

databases.

You must place the database driver files in the Forte for Java lib/ext directory

before you start the Forte for Java IDE. If you do not do this, the dbschema wizard

does not enable you to select the proper database driver when you create a new

schema. You cannot mount the driver file in the IDE’s Explorer to do this, nor can

you simply place the driver file in the CLASSPATH environment variable. You must

copy the driver file into the lib/ext folder.

The same database driver must also be added to the $J2EE_HOME/lib/system
directory so that the application server is aware of the new database driver. Read the

information contained in ffj-install-dir/j2sdkee1.3/doc/release/
ConfigGuide.html#12442 for more information on required steps for adding

more database drivers to the J2EE Reference Implementation application server.

j2eeadmin -addJdbcDatasource jndi_name url

jdbc.DataSource.0.url=jdbc:pointbase:server://localhost/ your-
database
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For more information on database configuration and adding new database drivers,

see: http://www.sun.com/forte/ffj/resources/articles/
configdb.html .
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CHAPTER 7

Using Other Application Servers
with the Forte for Java IDE

Once you have successfully installed the IDE and validated the IDE installation by

creating a simple J2EE application (see “Validating Your Forte for Java Installation”

on page 37 for more information), you may use other application servers with the

IDE.

This chapter contains information about using other products as the default

application server to use with the applications you developed with the Forte for Java

IDE.

Integrating the BEA WebLogic Server 6.1
With the IDE

It is assumed that you have installed and started the BEA WebLogic Server 6.1

before you can use it with the IDE. Follow the steps below to configure the BEA

WebLogic Server 6.1 SP2 with the Forte for Java IDE.

Note – The BEA WebLogic Server 6.1 SP2 has been certified with this release of the

Forte for Java IDE and is only certified by BEA to run with the JDK, v.1.3.1 software.

Note – There is a known problem in deploying web services developed with the

Forte for Java IDE to the WebLogic 6.1 Application Server. The fix requires a patch to

the WebLogic 6.1 Application Server. You will not be able to deploy web services

from the IDE to WebLogic 6.1 without the patch. WebLogic customers with BEA

support contracts need to contact BEA Customer Support and request the patch for

issue CR064391.
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Setting the BEA WebLogic Server 6.1 as the

Default Application Server for the IDE

Follow the steps below to make the BEA WebLogic as the default application server

to be used by your applications you create and deploy in the IDE.

1. If you have not already done so, invoke the IDE.

See “Using Your Newly Installed Forte for Java IDE” on page 31 for instructions on

how to invoke the IDE.

2. Expand the Server Registry/Installed Servers node from the Runtime tab of the
Explorer window.

You should see the node WebLogic Server 6.1 node.

3. Right-click the WebLogic Server 6.1 node and select Properties.

The property sheet for the WebLogic Server appears.

4. Set the value for the WebLogic Home property.

a. Select the WebLogic Home property

b. Type the weblogic-install-dir/wlserver6.1 . and close the property sheet.

5. Add a WebLogic Server instance by right-clicking the WebLogic Server 6.1 node
and selecting Add Server Instance.

6. Set the password value in the property sheet.

a. Right-click the WebLogic Sever instance you just created and select Properties.

The property sheet for the instance appears.

b. Select the Password property and type the password you specified during the
WebLogic Server installation as the property’s value.

c. Close the property sheet.

7. Right-click the WebLogic Server Instance 1 and select Set As Default Application
Server.

The WebLogic Server is now the default application server used by the IDE.
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CHAPTER 8

Where to Go From Here

This chapter contains information about available documentation resources and how

to obtain IDE updates from the Forte for Java Update Center.

Updating Modules With the Update
Center

Once you have Forte for Java, release 4.0 installed in your system, use the Update

Center to add new IDE modules or update the existing IDE modules already

installed in your system. Use the following steps to update your IDE.

1. Start the IDE.

See “Using Your Newly Installed Forte for Java IDE” on page 31 for instructions on

how to start the IDE.

2. Select the Update Center from the IDE’s Welcome screen or choose Tools > Update
Center from the Main window of the IDE).

The Update Center wizard appears.

3. Select Forte for Java Update Center as the Update Center to connect and deselect
NetBeans Update Center.

4. Click the Proxy Configuration to set your proxy configuration, if needed.

The Proxy Configuration dialog appears.

a. Modify the values as needed and click OK to return to the Update Center
wizard.
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5. Click Next and type your Forte for Java Update Center login name and password.

See “Registering With Forte for Java Developer Resources” on page 33, for

information on registering and creating a login name and password.

The Update Center displays the modules that are available to you.

6. Select individual modules or select all by clicking the >> button. Use the < button
to remove those versions that are not appropriate to your platform.

7. Click Next and follow the Update Center installation procedure.

The IDE installs the selected modules, then restarts itself.

For more information about how the Update Center works and Sun’s privacy policy

regarding your personal information, see the Developer Resources Site FAQs at

http://forte.sun.com/ffj/resources/sitefaq.html .

Other Documentation Resources

You can access the following resources to learn more about the different features of

the IDE and how to use them.

■ The online help is available by accessing the Help menu from the Main window

of the IDE. You may view the available help sets by clicking Help Sets from the

Help menu.

■ A set of programming books, tutorials and code examples are available at

http://forte.sun.com/ffj/documentation/index.html
■ The Forte for Java Developer Resources site at

http://forte.sun.com/ffj/index.html also contains a wealth of

information and support resources, including Forte for Java news, technical

articles, a support knowledge base, forums and more.

You can also access this site from the IDE by selecting Help > Web Resources from

the Main window of the IDE.
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CHAPTER 9

Troubleshooting

This chapter provides some troubleshooting hints to help you during the

installation, start up, or configuration of the Forte for Java IDE.

Forte for Java IDE Installation

The following describes some errors you may encounter during the Forte for Java

IDE installation.

1. Error: Error writing file = Not enough temporary disk space

If you received an error similar to the following, use the solution below to

continue with the Forte for Java IDE installation.

■ Solution: Invoke the installer with the -is:tempdir commandline option.

For example, on a Solaris operating environment, type the following:

2. Error: Could not find JVM

$ InstallShield Wizard

Initializing InstallShield Wizard...

Searching for Java(tm) Virtual Machine...
...............................
Running InstallShield Wizard...
Error writing file = There may not be enough temporary disk space.
Try using -is:tempdir to use a temporary directory on a partition
with more disk space.

$ ffj_ee_solsparc_en.bin -is:tempdir /temp javahome
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If you received an error similar to the following, use the solution below to

continue with the Forte for Java IDE installation.

■ Solution: Invoke the installer with the -is:javahome command line option.

For example, on a Solaris operating environment, type the following:

Forte for Java IDE startup

The following are some error messages you might have received during

configuration of the newly installed Forte for Java IDE software.

1. Error: No J2SE was found at /usr/j2se/bin/java

■ Solution: Install the J2SE v.1.4.0 software on your system.

For Solaris operating environment, include any patches needed. Refer to

“Installing the J2SE, v. 1.4.0 Platform” on page 9 for more information. on

installing J2SE, v. 1.4.0 on your system.

$ InstallShield Wizard

Initializing InstallShield Wizard...

Searching for Java(tm) Virtual Machine...
...............................
Could not find JVM

$ ffj_ee_solsparc_en.bin -is:javahome javahome

$ ./runide.sh
$ ERROR: No J2SE was found at /usr/j2se/bin/java.
ERROR: The following required 5.7 patches have not been installed
on system "yourmachine": 106950-16 106327-11 106541-17 106980-17
108376-29 107656-07 107081-37 107636-08 107702-08 108374-05
107226-18 108244-03 106748-04 106300-12 107058-01
NOTE: For help with the J2SE and patch installs please refer to
the file /opt/SUNWspro/prod/READMEs/client_readme.txt, or talk to
your system administrator.
Current runtime environment is not compatible. Exiting...
[1]    Exit 2               ./runide.sh
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2. Error: Unable to load java.dll

■ Solution: Make sure there is no space in the name of the directory in which you

have installed the J2SE, v.1.3.1 or J2SE, v.1.4.0 platform.

3. Forte for Java IDE is not pointing to the J2SE, v.1.4.0 platform you had specified

during the IDE installation.

If you have had specified the location of the J2SE, v.1.4.0 platform during the

Forte for Java IDE installation, but the IDE is not pointing to that location, you

may have received an error similar to the following:

■ Solution: Check the JAVA related environment variables already set prior to

invoking the IDE and unset them.

The values of the $JAVA_PATHand $JDK_HOMEenvironment variables

override the value of the J2SE path you had specified during the IDE

installation. You need to unset these environment variables or use the -
jdkhome command line option when starting the IDE.

Web Services

The following are some error messages you might get when using UDDI or the J2EE

Reference Implementation server.

Using UDDI

1. To publish Web services to a UDDI registry, Netscape 6.2 is required.

2. IllegalArgument Exception

$ ./runide.sh
ERROR: The J2SE[tm] 1.3.0 found at /yourmachine/jdk1.3/bin/java
cannot be used by Forte Enterprise Edition. J2SE[tm] 1.4 is
recommended.
NOTE: You can download and install the J2SE[tm] related Solaris[tm]
operating environment patches from
http://access1.sun.com/fortedevprod or see your system
administrator.

Current runtime environment is not compatible. Exiting...

[1]    Exit 2               ./runide.sh
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If you intend to use UDDI, you need to set the User Proxy Server name and port

information when you first run the Forte for Java IDE. If you do not set the User

Proxy Server name and port, you will get an illegalArgumentException
when searching for anything in a UDDI registry using the New Client wizard.

■ Solution: Set the User Proxy Server information.

You can use either of the following to set the User Proxy Server information:

i. When you start the IDE after installation, specify the User Proxy Server

name and port from the second popup window.

ii. Choose Tools > Setup Wizard from the Main window of the IDE and

provide the User Proxy Server name and port.

You must restart the IDE for the values to take effect.

Using the J2EE RI Server

1. Error: java.lang.RuntimeException: Could not initialize j2ee
server

If another instance of the server is already running, you might get the above error

message.This error occurs if another application has already taken the port

number the J2EE Reference Implementation server is trying to use.

■ Solution: Reboot the J2EE Reference Implementation server to get the port

number before the other application does, or you can troubleshoot the error by

using the following steps:

i. Open your $J2EE_HOME\config\orb.properties file and make a note

of the port and serverport numbers.

ii. Use the netstat command to see if the numbers are in use.

For example, on a Solaris operating environment or Microsoft Windows

system: type something similar to the following.

iii. If the numbers are in use, try re-running the command and removing the

last couple of digits of the port_number.

For example, on a Solaris operating environment, you might type:

$ netstat -a | grep port_number

$ netstat -a | grep 104
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This command will list all of the 104 ports in use. If there is a number

missing, change the $J2EE_HOME\config\orb.properties file to the

number missing from the list. You may need to do this for both the port and

server port numbers.

Using WebLogic 6.1

There is a known problem in deploying web services developed with the Forte for

Java IDE to the WebLogic 6.1 Application Server. The fix requires a patch to the

WebLogic 6.1 Application Server. You will not be able to deploy web services from

the IDE to WebLogic 6.1 without the patch. WebLogic customers with BEA support

contracts need to contact BEA Customer Support and request the patch for issue

CR06439
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APPENDIX A

Solaris Patch Identifications and
Descriptions

This appendix provides the Solaris™ patch identification numbers and descriptions

of the patches included with the Java™ 2 Platform, Standard Edition 1.4.0 (J2SE™,

v.1.4.0 platform) installation.

TABLE A-1 lists the Solaris patch identification numbers and description for the

Solaris™ 8 SPARC Platform Edition.
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TABLE A-1 Patch Identifications and Descriptions for Solaris 8 SPARC Platform Edition

Patch Identification Number Patch Description

109147-14 Solaris 8 interprocedural optimizer

108434-04 Solaris 8 libC sparc

108435-04 V9 libC

111293-04 /usr/lib/libdevinfo.so.1

112334-01 /usr/include/sys/archsystem.h

111310-01 /usr/lib/libdhcpagent.so.1

108528-13 SIGEMT

108652-40 Xserver

108921-13 CDE 1.4 dtwm

108940-40 Motif 2.1

108773-12 X input methods

109607-01 /usr/include/iso/stdlib_iso.h
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